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1 Introduction

1.1 Introduction

Preparation Gilson + SampleTrack (PrepGilsonST) is a sample preparation program 
which controls a Gilson "215" or "235" instrument with additional "8xx" valves and 
"ValveMate".

Predefined preparation step procedures can be modified by the user and will be exe-
cuted.

Depending on the application type, a barcode reader identification can be used and 
orders can be defined by the "SampleTrack" program.

The type of destination racks can be specified and used to define destination positions 
automatically.

When SampleTrack is not used, the user can create orders when defining source sam-
ples, procedures, and push solvents.

Note: Throughout this manual Preparation Gilson + SampleTrack will simply be referred 
to as PrepGilsonST.
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1.2 Warnings and Notes

There are two types of information notices used in this manual. These notices highlight 
important information or warn the user of a potentially dangerous situation. The following 
notices will have the same level of importance throughout this manual.

Note: Indicates important information or helpful hints

WARNING: Indicates the possibility of severe personal injury, loss of life or equip-
ment damage if the instructions are not followed.

1.2.1 Note on SPE Tube Transfer 

For information on the “SPE-TT System” refer to the SPE-TT tutorials 1.1 and 11 or the 
manual SPE-TT system Installation and Users Manual for Solid Phase Extraction Tube 
Transfer Systems available from Bruker.

1.3 Contact for Additional Technical Assistance

For further technical assistance on the PrepGilsonST, please do not hesitate to contact 
your nearest BRUKER dealer or contact us directly at:

BRUKER BioSpin GMBH 
am Silberstreifen 
D-76287 Rheinstetten 
Germany 
 
Phone:+ 49 721 5161 0 
FAX:+ 49 721 5171 01 
E-mail:martin-beck@bruker-biospin.de 
Internet:www.bruker.de
10 Z31695_00_05
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2 Safety

2.1 General Safety Instructions

The PrepGilsonST program controls the NMR 215 Liquid Handler machine.

For safety reasons you should read this manual before setup and first usage of the NMR 
215 Liquid Handler. Keep this manual near the Liquid Handler for later reference. It must 
be ensured that all persons who have to perform activities on the machine, have access 
to the operating manual at all times.

• The machine may only be operated by persons who have been specially trained, 
briefed and authorized. They must be familiar with the operating manual and act in 
accordance with it.

• Never touch moving parts on the device. Always wait until all parts come to a com-
plete stop. With a cover installed, the operating status is indicated with a green light 
on the cover. The PrepGilsonST program shows in this case the status „finished 
OK” (with a green icon) or „Error” (with a red icon) for each order in the order table 
on the screen. 

• After the final sample preparation the device must come to a complete stop, and the 
needle must have reached its home position, before any further work can be started 
at the liquid handler or before it is left unattended.

• Always switch the power to off when making adjustments to the liquid handler. The 
potential exists for bodily harm if you interfere with the work area of the instrument 
while it is running.

• The supply voltage must be identical to the specifications on the rating plate.

• All labels on the machine which display safety and operating instructions must 
always be kept legible. Worn or damaged labels must be replaced immediately.

• If erroneous behavior of the NMR 215 Liquid Handler or accessories occurs during 
operation, shut the machine down, remove the power supply and contact customer 
service.

• If there is visible damage to any of the devices or the power cables, these must not 
be operated. Consult a technician before reactivating the device again.

• Improper repairs may result in major hazards for the user. Never disassemble the 
device on your own nor try to repair it yourself.

• Use only original equipment manufacturer (O.E.M.) accessories.
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2.2 Correct Usage

The machine NMR 215 Liquid Handler is intended exclusively for:

• Preparing and transferring a liquid sample out of a suited vessel into a NMR flow 
probe or into another vessel.

• Preparing means to dilute and mix a sample using the dilutor of the NMR 215 Liquid 
Handler and the probe mounted to the Z-arm. The sample can also be moved into 
another vessel.

• Transferring means to take a prepared sample into the NMR 215 Liquid Handler 
capillary, connecting the capillary to an injection port and pushing it via a transfer 
capillary to the measurement cell of the NMR flow probe or MS instrument.

• Correct usage also includes reading this operating manual and complying with all 
the instructions it contains - in particular the safety instructions. Furthermore, all 
inspection and maintenance work must be carried out at the stipulated intervals.

The machine is not designed for applications other than those listed here - this is consid-
ered improper use! In particular we advise that the following is prohibited:

• When the liquid handler is used inside the cover (hood) the service doors in the rear 
must be closed during operation. These doors are to be used for service and set-up 
only and must be kept closed during normal operation. The extra safety functionality 
of the cover only apply if these doors remain closed. In addition, the inert gas atmo-
sphere will escape and provide a danger for personnel.

If the machine NMR 215 Liquid Handler is not used in accordance with these conditions, 
safe operation of the machine cannot be guaranteed.

The NMR 215 Liquid Handler manufacturer is not responsible for any injury or damage 
to persons or property resulting from improper use of the device. 

2.2.1 Danger of Injury from the Liquid Handler

The robotic movement of the liquid handler is very fast and may surprise anyone 
not familiar with its operation. While the arm of the liquid handler will stop if there 
is something in it's way, it might still cause bruises or may, for example, push 

your arm into glass tubes and cause cuts.

The needle is meant to pierce thick septa and has the power to cause deep pain-
ful cuts. If it should hit a nerve or joint, it might also cause a permanent defect of 
the hand. Therefore do not reach within the work area of the robot while it is 

operational and ensure that others are protected from injuries as well. 

Our cover (hood) provides added safety to operating personnel and helps prevent acci-
dents. The cover must be installed also in the "Base Configuration" on page 49 of the 
PrepGilsonST software.

After starting a preparation with a cover installed, the user must wait until the green or 
red light on the cover is ON before accessing parts of the Gilson manually.

Without a cover installed, the NMR 215 Liquid Handler is working after the user has 
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started the automation. The working status is indicated with a blue status background 
color and status text „running” of the „Gilson Control” of the PrepGilsonST program view. 
At least one order in the order table on the screen has the status „Procedure running” or 
„Verified: Ready to run”.

When all working operations are finished for each order in the order table on the screen 
the status „finished OK” (with a green icon) or „Error” (with a red icon) is displayed. The 
„Gilson Control” shows a green or red status background color and the status text „fin-
ished” or „error”.

With the cover installed, the checkbox "Reaction when opening the cover (stop and wait 
until closed)" must be selected in the "Gilson Cover & LED Configuration" on page 65, to 
provide the higher security level.

2.2.2 Danger from Samples and Other Substances

For the operation of the BEST - NMR 215 Liquid Handler no dangerous liquids, 
solvents or gases are required. However you may wish to use potentially dan-
gerous substances or samples (poisonous, corrosive, infectious, radioactive, 

etc) for your experiments. The usage of these substances requires special attention and 
different safety regulations may apply. The operator is responsible to meet these special 
requirements (ventilation, first aid installations, personal protection, etc). Also observe 
any instructions on the liquids, solvents or gases containers.

When operating with dangerous substances, you must be particularly aware of 
the potential threat of the needle or breaking glass. While injuries from the nee-
dle would be painful, the threat of substances reaching the bloodstream through 

open wounds is potentially lethal. 

.Therefore never reach within the work area of the robot while it is operational 
and make sure others are protected from this danger

If the liquid handler is used in an inert gas atmosphere, it may be necessary to 
monitor the oxygen levels or ensure adequate ventilation.
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2.2.3 Before Starting

Familiarize yourself sufficiently with:

• The machine's operating and control elements.

• The machine's fittings.

• How the machine works.

• The immediate environment of the machine.

• The safety devices.

• Measures to be taken in case of an emergency.

2.3 Explanation of the Safety Symbols

This symbol indicates primarily danger to personal health, but damage to the machin
property or the environment is also possible.

Failure to observe these warnings could result in serious, even fatal, injuries.

Caution

This symbol is found on the rear of the Cover above and on the service doors. Whe
these doors are open one can reach within the work area of the needle, without dis
abling the robot. These doors are intended for easier handling and set up, but must
closed during normal operation. Make sure these doors are in their proper position
before starting the machine. When you intend to make adjustments through these 
openings make sure that the robot is shut down and that you do not reach in the wo
area of the robot.

 

This symbol indicates danger of injuries to hands or arms.

Failure to observe these warnings could result in serious cuts and bruises and may
even result in permanent damages.

Warning

This symbol is found near the needle of the robot. The strong Z-drive of this robot i
meant to pierce thick septa. Keep your hands clear of the entire work area and esp
cially from the needle.
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2.4 During Service

The servicing tasks defined in the „SamplePrep & BEST NMR” operating manual - tun-
ing, cleaning, lubrication, maintenance - must be performed when due.

Before performing the serve work, you must observe the following:

• Personally ensure that all potentially dangerous substances have been removed. 
Be aware that capillaries, the syringe, the needle or other devices may still contain 
unknown substances.

• Switch off the central power supply using the master switch, whenever an operation 
does not specifically require the robot to be switched on.

• Strictly follow the procedures described in the manual. Repairs, inspections or ser-
vicing procedures not described in the operating manual must be performed by 
BRUKER technicians.

• Replace all defective machine parts immediately

• Use only OEM replacement parts

After completing the service work and before starting the machine, you must observe the 
following points:

• Check that all previously removed protective devices, covers, container lids and fil-
ters have been replaced correctly. The service doors on the rear of the BEST Cover, 
if used, must be in place.

• Make sure that all previously used tools, materials and other equipment are 
removed from the operating area.

• Make sure that all the machine's safety devices are functioning properly.

This symbol indicates danger of automatic moving parts.

Failure to observe these warnings could result in cuts and bruises.

Warning

This symbol is found on the arm of the robot. The robot moves at high speeds and 
might push your arm or hand against a wall or into glass tubes. Always be aware o
sudden movements. Never reach into the work area of the robot while the robot is 
operational.
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2.4.1 Changes to the Machine

For safety reasons, no unauthorized changes may be made to the machine.

The safety features must not be changed, removed or otherwise altered.

All planned changes must be authorized in writing by the responsible BRUKER com-
pany.

Use only OEM replacement parts. These parts are especially designed for the machine. 
With non-OEM parts there is no guarantee that they have been designed and built to 
comply with the stress and safety requirements of the machine.

Parts and special fittings which were not supplied by BRUKER are also not approved for 
use in/on the machine.

2.5 Safety Evaluation

It is recommended, and in some countries is required, that the operator evaluates the 
safety of the set-up and environment of the machine. On the bases of this report he 
should prepare special work instructions and procedures for the employees to ensure 
maximum safety.
16 Z31695_00_05



Z3169

-

-

-

 

3 Menus

3.1 The Main Menu

The main menu consists of:

"File Menu Commands" 

"Edit Settings Menu"

"Preparation Menu Commands"

"Service Tools Menu Commands"

"Clean Procedures Menu Commands"

"View Menu Commands"

"Help Menu Commands"

3.2 File Menu Commands

The File menu offers the following commands: 

Table 3.1  The File Menu Commands

Application Settings

Open Current Session
Opens the current session file 
curr_session.pgi.

Open Old Session Opens an old session file *.pgi

Save...As
Saves the current session file under a dif
ferent file name.

Save Current Protocol (...log) Files Saves the current protocol files.

Open Print Dialog
Opens the print dialog box allowing selec
tion of print options for the current order 
protocol.

Compare Procedures Dialog
Opens a dialog box allowing the compari
son of procedures.

Configuration save/load
Used to backup and reload configuration
files *.cfg and *.735.

Exit Exits the PrepGilsonST program.
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3.2.1 Application Settings

3.2.1.1 Open Current Session

Use this command to reload the current session (settings) file (curr_session.pgi) after 
checking an old session file. 

The current session file is loaded automatically when the program is opened and the 
application type is selected (see "Default Procedure Selection" on page 45).

The name of the current session file is visible in the caption of the main window. The 
content of the current session file can be viewed in the Edit Settings dialog box (see 
"Edit Settings Menu").

Shortcut Keys: CTRL+O

3.2.1.2 Open Old Session

Use this command to open an old session file (*.pgi) in the PrepGilsonST program.

This is used only to view the old session file contents in the "Edit Settings Menu". Sev-
eral menus will be disabled and the contents cannot be changed and saved. After open-
ing an old session the program should be closed and reopened for automatic 
preparation.

The name of the current session file of the selected application will remain visible in the 
caption of the main window.

3.2.1.3 Save... As

Use this command to save the active session as a file with another name (only used for 
checking the settings at later time!).

PrepGilsonST displays the Save As dialog box so you can name the file.

3.2.2 Save Current Protocol (... log) Files

Saves the current protocol files. During this procedure a copy of the current protocol files 
are produced as follows:

log_current.log saved to ...\G215Data\Exec\saved_log_current.log

log_exec.log saved to ...\G215Data\Exec\saved_log_exec.log

A copy of the session file is also made:

curr_session.pgi saved to ...\G215Data\Exec\saved_curr_session.pgi
18 Z31695_00_05



Z3169

Menus
3.2.3 Open Print Dialog

Selecting this menu option will open the Print Order List dialog box where all informa-
tion for the automatically generated print list can be selected:

Figure 3.1 Print Order List Dialog Box

For each header combination of procedure files and solvents, one separate list will be 
generated. For example for the order list... 

...the following print list will be generated, saved in the PrintOrderList.txt file and then be 
displayed in the Notepad program.
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The Print List will be saved in the default print file:

[Order Folder]\bstsdata\gilson\out\protocol\PrintOrderList.txt (when running with 
SampleTrack)

[Order Folder]\bstsdata\gilson\out_no_ST\protocol\PrintOrderList.txt (when run-
ning without SampleTrack)

3.2.4 Compare Procedures Dialog Box

With the Checkbox “Compare folders“ disabled, two single procedures can be com-
pared.

With the Checkbox “Compare folders“ enabled, all procedures of the selected folder can 
be compared.

Figure 3.2 Compare Step Procedures Dialog Box
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When comparing all procedures in two folders the color in the Procedure List shows the 
procedure status:

• Green: No differences between the procedure in first and second folder.

• Blue: Differences detected between the procedure in first and second folder.

• Red: The procedure in the first folder does not exist in the second folder.

In the two procedure text boxes for the first (left) and the second folder (right) different 
lines of the selected procedure are displayed “blue“ (in the column “NR“), e.g. line 3 and 
5 in the example.

3.2.5 Configuration Save/Load

Backups and reloads the configuration files *.cfg and *.735 of the current application in 
the working folder [Install Folder Data]\G215Data\Config\.

Figure 3.3 The Load/Save Configuration Dialog Box
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Default config files for each Application are written at Installation time into the Install 
folder: [Install Folder Data]\G215Data\Config\Restore\

When starting an Application the program is checking if config files are existing in the 
working folder: [Install Folder Data]\G215Data\Config\

If there are no files found, a copy of the default files from the Install folder 
...\Restore\ will be moved automatically into the working folder.

Note: For applications with SampleTrack (Profiler, SampleTrack) the tray configuration is 
grayed (only automatically changeable using the barcode reader). 

3.2.6 Exit

Exits the PrepGilsonST session. You can also use the Close command on the applica-
tion control menu. The program will prompt you to save documents with any unsaved 
changes if applicable.

Shortcuts: 

• Double-click the applications control menu button, or 

• click on the close button, 

• or press ALT + F4.

3.3 Edit Settings Menu

3.3.1 For Applications with SampleTrack (Profiler, SampleTrack)

The Edit Settings menu opens the Edit Settings dialog box from SampleTrack where 
the following preparation modes can be defined:

• Web service server URL.

• Procedure export folder.

• SampleTrack order folder.
22 Z31695_00_05
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Figure 3.4 The Edit Settings Using Web Service Dialog Box

Reset to default settings values and save:

Restores all setting values to the default values delivered with the installation in the 
file „...\G215Data\Exec\Restore\default_session_xxxx.pgi“ (“xxxx” depends on the 
selected application type).

3.3.2 For Applications without SampleTrack (Easy, SPETT)

The Edit Settings menu opens the Edit Settings dialog box where the following prepara-
tion modes can be defined.
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Figure 3.5 The Edit Settings Dialog Box 

Table 3.2  Description of the Edit Settings Fields

Folders for Proce-
dures and Orders

Order Folders Orders and protocols are stored in the path of 
edit box Order Folders + \in_no_ST\

Mode of Used Destina-
tion Tubes

Using Destination 
Matrix

If checked, the field Destination Matrix Type
used to find an empty destination matrix of t
type for orders loaded in the currently inser
source racks.
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Manually Destination 
Selection

If checked source tubes and destination tubes c
be defined in the Create Orders dialog box (s
"Create Orders" on page 97).

If this is not checked only source tubes can 
defined in the Create Orders dialog box and de
nation racks shown in the Automatically us
Destination Matrix Type field will be used au
matically.

Preparation Mode Verify Each Proce-
dure Only One Time

Procedures with the same name will be check
only one time before execution.

Automatic Clean Pro-
cedure

The Clean Procedure name is defined in 
"Configuration" section (see also "Clean Pro
dures Menu Commands").

Select the appropriate options to run this pro
dure before the beginning of the order proced
loop OR/AND after the last order.

Sort Orders mode Sort Orders Inside 
Rack By

Orders can be sorted inside racks by Creati
time (default), Position, or Solvent.

Reset Default Values The reset default values button restores all sett
values to the default values delivered with 
installation in the file:

„...\G215Data\Exec\Restore\default_session_
xx.pgi 

(„xxxx“ depends on the selected application type

Table 3.2  Description of the Edit Settings Fields
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3.4 Preparation Menu Commands

The Preparation menu offers the following commands: 

3.4.1 Start Preparation Automation

3.4.1.1 For Applications without SampleTrack (Easy, SPETT)

When the automation is started using one of the shortcuts listed below, a new prepara-
tion loop for all available orders will be started:

• Initialize Gilson

• Read Barcodes if the barcode reader is selected in the configuration.

• Deletes all old orders.

• Load orders 

• Verify orders

• Run default Clean procedure if selected in the settings dialog box.

• Run Preparation procedures loop (for all available orders).

• Run default Clean procedure if selected in the settings dialog box.

Table 3.3  The Preparation Menu Commands

Start Preparation Automation
Start Automation = Init + Read Barcodes + Read 
Orders + Verify + Preparation

Start Verify Test All Orders 
Test Loop

Starts the verify test loop for Profiler applications.

Pause after current movement
Stops after the current movement and waits. Select 
the menu Continue to continue the preparation.

Continue Continues the preparation after Pause.

End after current order Stops after the current order and finish order loop.

Abort current order Aborts the current order and finish order loop.
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3.4.1.2 For Applications with SampleTrack (Profiler)

A new preparation loop will be started:

• One order will be loaded via the web service server, verified and executed before 
the next order will be requested.

• All urgent order will be delivered from the SampleTrack web service server first.

Select the menu "Preparation Pause" or the Toolbar  to stop the preparation.

Select the menu "End After Current Order" or the Toolbar  to stop after current 
order and to finish the order loop.

Select the menu "Abort Current Order" or the Toolbar  to abort the preparation 
immediately.

Shortcuts: Toolbar:   or Keys:CTRL+A

3.4.2 Start Verify Test Loop for All Orders

If the user wants to check all available orders when starting the program this menu could 
be used.

3.4.2.1 For Applications without SampleTrack (Easy, SPETT)

A new verification test loop for all orders will be started: 

• Initialize Gilson.

• Read Barcodes if the barcode reader is selected in the configuration.

• Deletes all old orders.

• Create orders in the Create New Orders dialog box.

• Load orders.

• Verify orders.

3.4.2.2 For Applications with SampleTrack (Profiler)

A new verification test loop for all orders will be started: 

• A test loop will be started.

• All available orders will be loaded from the Web Services server.

• All available orders will be verified.

• All available orders will be removed from the order list and the status will be reset 
via Web Services.

When the Test is running, the text “Test Verify All Orders“ will be displayed:
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3.4.3 Preparation Pause

Preparation pause: Stops after current movement and waits for the menu "Continue". 
Select the menu "Continue" or the Toolbar  button to continue the preparation.

3.4.4 Continue

Select this menu to continue the preparation after Pause.

Shortcuts: Toolbar  

3.4.5 End After Current Order

Stops after the currently running order and finishes the order loop.

Shortcuts: Toolbar 

3.4.6 Abort Current Order

The currently running order will be stopped immediately with an error status and if the 
order loop was running it will be stopped. A Home Seek will be performed automatically.

Shortcuts: Toolbar 

3.5 Service Tools Menu Commands

The Service Tools menu offers the following commands: 

Table 3.4  The Preparation Menu Commands

Initialize Gilson Initializes the Gilson instrument.

Initialize Pump Initializes the Gilson instrument and the dilutor pump.

Initialize + Home
Initializes the Gilson instrument and performs a home 
seek.

Read Barcodes Runs the Read Barcodes task.
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3.5.1 Initialize Gilson

Note: Menu enabled only for applications without SampleTrack (Easy, SPETT).

Runs the Initialize Gilson task:

1. Write procedure List file of all usable procedures in SampleTrack.

2. Write solvent List file of all defined solvents for SampleTrack.

3. Start to write a new Current protocol file.

4. Reset Errors.

5. Set Gilson Z Tower clamp height variable.

6. Set Gilson liquid level detection threshold variable.

7. Initialize barcode reader (if installed).

8. Checking Z axis.

9. Checking XY axis.

10. Checking Dilutor pump (not homing!) 

3.5.2 Initialize Pump

Runs the Initialize Pump task: 

Create New Orders Dialog Creates new orders dialog box.

Load New Orders and Verify Loads orders from order directory and verifies orders.

Prepare all Orders Prepares the orders.

Modify Procedure
Shows or hides a Procedure View in the main window
order to modify task procedures at a high edit level for 
customers.

Connect Gilson Connects the Gilson after changing the configuration.

Delete Map: Source-Destination 
Matrix

Delete Map: Source destination matrix

Change Syringe For service personnel only! Used to change the syring

Delete all Orders and Protocols 
in ST Folders

Reloads the configuration file.

Test: Check Positions in Tray
Special dialog box used to check all XYZ positions in t
tray (racks, ports, etc.).

Table 3.4  The Preparation Menu Commands
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1. Writes a procedure list file of all usable procedures in SampleTrack.

2. Writes a solvent list file of all defined solvents for SampleTrack.

3. Starts to write a new current protocol file.

4. Resets errors.

5. Sets the Gilson Z-tower clamp height variable.

6. Sets the Gilson liquid level detection threshold variable.

7. Initializes the barcode reader (if installed).

8. Checks the Z-axis.

9. Checks the XY-axis.

10. Checks the dilutor pump at the rinse station.

3.5.3 Initialize + Home Gilson

Note: Menu enabled only for applications without SampleTrack (Easy, SPETT).

Runs the Initialize + Home Gilson task. 

1. Write procedure list file of all usable procedures for order creation.

2. Write solvent list file of all defined solvents for order creation.

3. Start to write a new current protocol file.

4. Reset Errors.

5. Set Gilson Z-tower clamp height variable.

6. Set Gilson liquid level detection threshold variable.

7. Initialize barcode reader (if installed).

8. Homing Z axis.

9. Homing XY axis.

10. Homing dilutor pump at rinse station.

3.5.4 Read Barcodes

Note: Menu enabled only for applications without SampleTrack (Easy, SPETT).

• Called automatically when starting automation loop with the start tool bar button.

Runs the Read Barcodes task.

1. Reads both ID and TYPE barcodes at all defined barcode racks (displayed with red 
frames in the barcode view of the tray configuration).

2. Deletes old barcode defined racks in the tray configuration if they are removed from 
the Gilson.

3. Creates new barcode defined racks and zones (with the name of the Rack ID bar-
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code) in the tray configuration if the barcodes are found.

All sites in the tray can be defined as barcode defined sites: See also "Barcode Zone 
Configuration" on page 58.

Figure 3.6 Working Area Configuration: Barcode Zones 

3.5.5 Create New Orders Dialog Box

Note: Menu enabled only for applications without SampleTrack (Easy, SPETT).

• Called automatically when starting the automation loop with the start tool bar button.

Orders can be created in this dialog box without SampleTrack.
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Figure 3.7 The Create Order Files Dialog Box

When checking File name with ’_ID’ an additional number will be added to the order 
name, so multiple orders for the same source position are possible. 

3.5.5.1 Create Orders SPE Tube Transfer

The solvent selection is grayed. The Delete Created Orders is enabled.

3.5.6 Load Orders and Verify

Note: Menu enabled only for applications without SampleTrack (Easy, SPETT).

Runs the Load Orders and Verify task (without Automation after Initialize and Read 
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Barcodes).

• Called automatically when starting automation loop with the start tool bar button.

For applications with SampleTrack (Profiler):

• Only called automatically when starting automation loop with the start tool bar but-
ton.

• One order will be loaded via WEB SERVICE Server, verified and executed before 
the next order will be requested.

• All Urgent orders will be delivered from the SampleTrack Web Service Server first.

3.5.7 Prepare Orders

Note: Menu enabled only for applications without SampleTrack (Easy, SPETT).

Runs the procedures preparation loop (for all available orders without Automation after 
Initialize, Read Barcodes, and Load Orders and Verify).

Called automatically when starting automation loop with the start tool bar button.

3.5.8 Copy Orders Back From...\in\save\

Copies orders from the directory ..\in\save into the directory ... \in\

Used for tests or if racks with the same Barcode ID and the same samples are used 
again.

Not used for „1 mm Sample preparation“ or „SPE Tube Transfer“ applications.

3.5.9 Modify Procedure

See "Edit Procedures" on page 85.

3.5.10 Delete Map: Source/Destination Matrix

Deletes all relations between the source Matrix ID Racks and Destination Matrix ID 
Racks.

Not used for 1mm Sample Preparation or for SPE tube transfer applications!

Only relevant with option „Preparation Mode: Using Destination Matrix” in the "Edit 
Settings Menu" dialog box!

After reading the Rack ID barcodes during the „Loading and Verifying Orders” proce-
dure, all orders will be checked if they need a new Destination Rack of the Destination 
Rack Type, as defined in the field „Destination Matrix Type” of the "Edit Settings Menu"
dialog box.

If there is no Destination Rack defined for the current Source Rack in the Source/Desti-
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nation Map, and an empty Destination Rack is found in the tray, then the current Source 
Rack of the Order and the empty Destination Rack will be written as “connected” into the 
Source/Destination Map. 

The Source/Destination Map will then be saved.

After restarting the program, or for new Source Rack orders in the Source/Destination 
Map, the Destination Rack will be the same.

If a Barcode ID is used more than one time (not recommended!):

• The customer must clear the Destination Rack and fill the Source Rack.

• If only the Source or the Destination ID has changed, this menu has to be used to 
delete all relations between Source Matrix ID Racks and Destination Matrix ID 
Racks.

3.5.11 Connect Gilson

NOTE: Not for BEST or Profiler applications!

This menu could be used to connect the Gilson liquid handler, if the Gilson is discon-
nected after an Error when starting this program. 

Typically the Gilson will be connected automatically when starting this program. If 
another configuration is used when starting the program with different values in the Gil-
son “non volatile memory” (e.g. Z-tower clamp height or syringe size) the Gilson reports 
an error and will be disconnected. In this case the user could close this program and 
restart again or use this command for correct connection to the Gilson.

3.5.12 Delete all Orders and Protocols in ST folders

Typically all executed orders and protocols will be saved in the appropriate file folders. 
This menu can be used to delete all orders and protocols in the appropriate file folders. 
The folder names are different depending on whether the current application is using 
SampleTrack or not (see "Directory Structure of Order Files" on page 81).

3.5.13 Test

3.5.13.1 Check Positions in Tray

Special dialog box used to check all XYZ positions in the tray (racks, ports, etc.).

3.6 Clean Procedures Menu Commands

The Clean Procedures menu offers the following commands, which enable you to 
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lu-
arrange multiple views of multiple documents in the application window: 

The procedures Clean Needle, Prime Dilutor and Prime Inject Port are defined in the 
default file configuration.

When the Default File Configuration is called from the clean procedures menu, the Gil-
son Liquid Handler 215 configuration is displayed in the configuration view.

3.6.1 Clean Needle

The clean needle menu command starts the clean needle procedure. The procedure is 
defined in the Gilson Liquid Handler 215 section of the configuration.

3.6.2 Prime Dilutor

Runs the Prime Dilutor procedure. 

The procedure is defined in the Gilson Liquid Handler 215 section of the configuration.

3.6.3 Prime Inject Port

Runs the Prime Inject Port procedure. 

The procedure name is defined in the Gilson Liquid Handler 215 section of the configu-
ration.

3.6.4 Set ValveMate Default Solvent Position

Moves ValveMate to the default solvent position (defined in "Dilutor Configuration" on 
page 52).

Table 3.5  The Clean Procedures Menu Commands

Clean Needle
The clean needle menu command starts the clean needle proce-
dure.

Prime Dilutor - Purge System Runs the Prime Dilutor procedure.

Prime Inject Port Runs the Prime Inject Port procedure.

Set ValveMate default solvent 
position

Moves ValveMate to the default solvent position (defined in the Di
tor configuration).

Modify Clean Procedure Opens the Clean TASK procedure edit dialog box.
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3.6.5 Modify Clean Procedures

Opens the Clean TASK procedure edit dialog box (see "Task Procedure Clean" on page 
87).

3.7 View Menu Commands

The View menu offers the following commands: 

3.7.1 Toolbar

Use this command to display and hide the Toolbar, which includes buttons for some of 
the most common commands in PrepGilsonST, such as File Open. A check mark 
appears next to the menu item when the Toolbar is displayed.

Table 3.6  The View Menu Commands

Toolbar Shows or hides the toolbar.

Status Bar Shows or hides the status bar.

Barcode List
Shows or hides the barcode list of connected source and des
nation barcode racks.

Modify Procedure
Shows or hides a Procedure View in the main window to mod
Task procedures at a high edit level for customers.

Configuration Shows or hides the configuration dialog box.

Tray Shows or hides the tray dialog box.

Main Protocol File Shows or hides the main protocol in the protocol dialog box.

Current Protocol File Shows or hides the current protocol in the protocol dialog bo

Procedure Steps Shows or hides the current master step procedure dialog box

Solvent Consumption 
Information

For applications without SampleTrack only. This command is
used to show a message box with the required solvent amoun
for all orders after the verification.

Error History

Shows the error history dialog box with all the errors which ha
occurred after starting the program. In each line of the list on
error will be displayed. When clicking on an error line all deta
of the error will be displayed in the information field.
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The Toolbar

The Toolbar is displayed across the top of the application window, below the menu bar. 
The Toolbar provides quick mouse access to many tools used in PrepGilsonST.

To hide or display the Toolbar, choose Toolbar from the View menu (ALT, V, T). 

Table 3.7  Menus with Toolbar Buttons

Start Preparation Automation
Start Automation = Init + Read Barcodes + Read Orders
Verify + Preparation.

Pause after current movement
Preparation Pause: Stop after current movement and wa
Select the Menu Continue to continue the preparation.

Continue Continue the preparation after a pause.

End After Current Order End after current order and finish order loop. 

Abort Current Order Abort current order and finish order loop.

Move Arm to Other Side
Moves the Gilson arm into a different position if the barc
reader did not allow the rack exchange.

Configuration
Shows or hides the Configuration View to see configura
details or to perform modifications if the instrument is no
running. 

Modify Procedure
Shows or hides a Procedure View in the main window to
modify task procedures at a high edit level for customer

Start Verify Test All Orders Starts the verify test loop.

Barcode List
Shows or hides the barcode list of connected source an
destination barcode racks.

Tray View Shows or hides the tray dialog box.

View Main Log File Shows or hides the main protocol in the protocol dialog 

Log File
Shows or hides the current protocol in the protocol dialo
box view.

Procedure Steps
Shows or hides the current master step procedure dialo
box.
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3.7.2 Status Bar

Use this command to display or hide the Status Bar, which describes the action to be 
executed by the selected menu item or depressed Toolbar button, and the keyboard 
latch state. A check mark appears next to the menu item when the status bar is dis-
played.

The status bar is displayed at the bottom of the PrepGilsonST window. To display or hide 
the status bar, use the Status Bar command in the View menu.

Figure 3.8 The Status Bar 

The left area of the status bar describes actions of menu items as you use the arrow 
keys to navigate through menus. This area similarly shows messages that describe the 
actions of Toolbar buttons as you depress them, before releasing them. If after viewing 
the description of the Toolbar button command you wish not to execute the command, 
then release the mouse button while the pointer is off the Toolbar button.

The right areas of the status bar indicate which of the following keys are latched down:

IndicatorDescription

CAPThe Caps Lock key is latched down.

NUMThe Num Lock key is latched down.

SCRLThe Scroll Lock key is latched down.

3.7.3 Modify Procedure

Shows or hides a Procedure View in the main window, which is used to modify Task pro-
cedures at a high edit level for customers.

See "Modifying the Procedure Dialog Box" on page 91.

3.7.4 Configuration 

Shows or hides the configuration view in order to see configuration details or to perform 
modifications if the instrument is not running (see "Open Configuration View" on page 
47).

Shortcuts: Toolbar 

3.7.5 Tray View

Shows or hides the tray dialog box. By moving the cursor over Containers (dark gray), 
Racks (light gray) or Tubes (colors defined) different information for the object under the 
cursor will be displayed in a yellow pop-up window:
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Figure 3.9 The Tray View Dialog Box 

Different view modes can be selected by checking the „Status“ or „Barcode“ check boxes 
in the View Mode block.

• When Status is checked the status information for each tube will be shown.

• When Barcode is checked the barcode defined racks will be highlighted within a 
red frame.

Shortcuts: Toolbar 

3.7.6 View Main Protocol File

Shows or hides the main protocol file with all the important information after the program 
is started.
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Figure 3.10 Main Protocol File 

This view can also be used to display other information:

1. Input order files from SampleTrack.

2. Output result order files to SampleTrack.

3.7.7 View Current Protocol File

Shows or hides the current protocol file with all the important information from the 
selected/current order.

This view can also be used to display other information:

1. Input order files from SampleTrack.

2. Output result order files to SampleTrack.

Shortcuts: Toolbar 
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3.7.8 Error History

This command is used to show a dialog box with all errors after starting the program:

Figure 3.11 The Error History View

In each line of the list one error will be displayed (old errors on the top of the list based 
on the time stamp).

When clicking on one error line all details of the error will be displayed in the information 
fields.
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3.7.9 Procedure Step View

Shows the Procedure Step View:

• Move the mouse cursor over one step, or click on the step icon to see details of one 
step!

• Shows the currently loaded or running main procedure in the upper part of the win-
dow.

• If there is a sub-procedure running, it is shown in the lower part of the window.

Figure 3.12 Procedure Step View 

Note:

• It is not possible to display the procedure as a text file, but only as a protocol text file 
after execution.

• For service personal only: Procedures that are not running can be displayed in 
the Procedure Editor program.

Shortcuts: Toolbar 
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3.8 Help Menu Commands

The Help Menu offers various options which provide assistance with this application: 

3.8.1 Help Tutorials

Use this command to open the windows explorer with the folder containing all tutorials 
as PDF and Powerpoint files. 

3.8.2 Help Manuals

Use this command to open the windows explorer with the folder containing the manuals.

3.8.3 About

Use this command to display the copyright notice and version number of your copy of 
PrepGilsonST.

Table 3.8  The Preparation Menu Commands

Help Tutorials Opens the explorer with the tutorials folder.

Help Manuals
Open the explorer with the documents folder containing the man
als.

About Displays the version number of this application
435_00_05



Menus
44 Z31695_00_05



Z3169
4 Start Selections

4.1 Defining Procedure Type

When starting the program the first time after installation the "Default Procedure Selec-
tion" dialog box appears enabling you to define the type of procedure and configuration 
settings in the registry.

Five types of procedures can be selected:

• Easy Preparation

• SPE Tube Transfer

• Profiler Preparation

•

After performing an initialization using the menu “Service tools” -> "Initialize Pump", all 
procedures in the Export directory (defined in the "Edit Settings Menu" dialog box) will be 
exported to enable a selection of these procedures in the selection box of SampleTrack 
or in the BEST program.

4.2 Default Procedure Selection

When starting this program after installation, the following box appears which allows you 
to define the application type (to perform different settings in the Registry), or to modify 
the path inside all the procedures: 

Figure 4.1 The Select Default Procedure and Configuration dialog box 

The following files will be set in the registry (in HKEY_LOCAL_MACHINE->SOFT-
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WARE->Bruker BioSpin->): 

The following „Current session” default files will be copied into the file  
\exec\curr_session.pgi:

1. Easy Preparation: default_session_Easy.pgi

2. SPE Tube Transfer: default_session_SPETT.pgi

3. Profiler Preparation: default_session_Profiler.pgi

If it is desired that this box does not appear the next time the program is started, please 
select:

• The check box „Do not show this dialog box again!” in this dialog box, or, 

• The check box „Do not show the Default Selection dialog box when starting the 
program!” in the "Edit Settings Menu" dialog box.

1. Easy Preparation: ->Gilson Control->ApplicType=7

->Gilson Control->GExecCtrl->Config file= \Config\default_Easy.cfg

->Gilson Control->EditProcedure->Procedure= \Proc\Easy\default_Easy.gsp

2. SPE Tube Transfer: ->Gilson Control->ApplicType= 5

->Gilson Control->GExecCtrl->Config file= \Config\default_SPETT.cfg

->Gilson Control->EditProcedure->Procedure= \Proc\SPETT\default_SPETT.gsp

3. Profiler Preparation: ->Gilson Control->ApplicType= 6

->Gilson Control->GExecCtrl->Config file= \Config\default_Profiler.cfg

->Gilson Control->EditProcedure->Procedure= \Proc\Profiler\default_Profiler.gsp
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5.1 Open Configuration View

To open the configuration view, start the program: 

Then press the Configuration View button from the tool bar.

Figure 5.1 The Configuration View dialog box 

Each of the different configuration sections are displayed inside a blue frame.
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By moving the mouse cursor around inside the blue frames, various configuration tool 
tips will be displayed:

By clicking inside the blue frames (here shown as yellow areas) special dialog boxes will open shown
various configurations.

"Base Configuration"
Defines the installed components of the 
configuration.

"Gilson Liquid Handler 
215 Configuration"

Defines default files and Gilson instru-
ment type specific configuration.

"Dilutor Configuration"
Defines the usable solvent list, the dilu-
tor syringes and the default solvent.

"Working Area Configura-
tion"

Defines the working area:
- "Tray File Configuration"
- "Solvents in Tray Configuration"
- "Reagent in Tray Configuration"
- "Barcode Zone Configuration"

"Z-Tower Configuration" Defines the needle adjustment.
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5.2 Base Configuration

In the base configuration dialog box the following items can be defined:

• The liquid handler type, either ’215’ or ’235’.

• The basic GSIOC ID.

• The serial ports (RS232) used (for the Gilson, barcode reader, and SPE tube trans-
fer).

• Other additional installation options used.

"Solvent Names Configu-
ration"

Defines the solvent names.

"ValveMate Configura-
tion"

Defines the Valvemate solvents.

"Valves & Capillary Con-
figuration"

Defines the valves and capillary config-
uration.

"Gilson Cover & LED 
Configuration"

Defines the reaction after opening the 
cover.
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Figure 5.2 The Base Configuration dialog box

5.3 Gilson Liquid Handler 215 Configuration

The Gilson Liquid Handler 215 configuration defines default files and the Gilson execu-
tion mode configuration.

5.3.1 Default Files Configuration

In the Default Files configuration, the following Gilson liquid handler 215 files can be 
configured:

• A default path for all procedures can be defined (application specific).

• When clicking on a line in the list, a default file for the selected type can be defined 
in a dialog box.
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Figure 5.3 The Gilson Default Files Configuration Dialog Box

5.3.2 Execution Mode Configuration

In the Execution Mode configuration, the following Gilson liquid handler 215 information 
can be configured:

• When the program is running, protocol files can be written.

• Different wash procedures can be defined for various ValveMate solvent changes.

• The Solvent Configuration button can be used to define solvent names in the 
"Dilutor Configuration".

• The Edit Solvent Positions at ValveMate button can be used to define solvent 
positions in the "ValveMate Configuration".
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Figure 5.4 Gilson 215 Execution Mode Configuration

5.4 Dilutor Configuration

The Dilutor Configuration dialog box can be used to define:

• The dilutor type (currently only “Type 402“ is supported):

• The number of syringes that can be used (currently only one syringe is supported);

• The size and the maximum speed of the syringe;

• A reduced maximum speed of the syringe.
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Figure 5.5 The Dilutor Configuration dialog box 

The Solvents Configuration button can be used to define solvent names in the "Sol-
vent Names Configuration" dialog box and provides a link to define solvent positions in 
the ("Tray File Configuration") dialog box.

5.5 Working Area Configuration

The Working Area Configuration allows configuration of the working area. The areas 
that can be configured depend on the applications that will be used. The working area 
for applications using SampleTrack are slightly different then those used without Sam-
pleTrack.

5.5.1 For Applications with SampleTrack (Profiler)

Four configuration dialog boxes are available for applications with SampleTrack:
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• "Tray File Configuration"

• "Solvents in Tray Configuration"

• "Reagent in Tray Configuration"

• "Ports in Tray Configuration"

5.5.2 For Applications without SampleTrack (Easy, SPETT)

Four configuration dialog boxes are available for applications without SampleTrack:

• "Tray File Configuration"

• "Solvents in Tray Configuration"

• "Reagent in Tray Configuration"

• "Barcode Zone Configuration"

Each application uses a different predefined default tray configuration file (*.735):

Application Easy:default_Easy.735 
Application SPETT:default_SPETT.735 
Application Profiler:default_Profiler.735 

The current default path can be checked in the Gilson Liquid Handler 215 configuration.

The solvent and reagent information and the tray file name can be saved in the *.cfg file 
(path written in the tool tip on the configuration name) and the tray information in the tray 
file *.735 when the Apply and OK buttons are pressed.

5.5.3 Tray File Configuration

For applications with SampleTrack (Profiler):

• Modification of racks and zones in the tray area are not allowed.

• All rack insert and remove operations are done automatically with the barcode 
reader.
54 Z31695_00_05



Z3169

Configuration
For applications without SampleTrack (Easy, SPETT):

Figure 5.6 The Tray Configuration dialog box for Applications without SampleTrack

Press the Apply or OK button to save the tray configuration to the *.735 file.

5.5.3.1 Adding Rack Tubes to a Zone

Only tubes assigned to a zone can be used in other configuration dialog boxes or in pro-
cedure steps.

1. Insert rack with a zone and tubes for one rack.

• A very fast way to define a tube when inserting a new rack manually.

• A new zone is defined after inserting the rack and all tubes of the rack will be added 
to the zone.

• See "Insert Racks with Barcode Simulation" on page 100.

2.Inserting rack tubes with a zone for more than one rack or for a part of one rack.

• The very flexible tube definition will be performed manually in three steps: 
- Insert a rack into a carrier (shown as a dark gray area, other names „container“ or 
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„site“. 
- Add a new zone (see "Adding Zones and Tubes to a Zone" on page 102). 
- Add tubes to a zone (see "Adding Zones and Tubes to a Zone" on page 102).

3.Insert racks with a zone and tube using the barcode reader.

• When a barcode reader is installed, tube definition will be done automatically when 
reading the barcodes of barcode defined racks (see "Barcode Zone Configuration" 
on page 58).

New customer racks could be created and modified using the context menu Rack Editor 
of the tray control (see "The Rack Editor" on page 67).

5.5.4 Remove Racks from the Tray

• Open the Tray Configuration in the Configuration View.

• Double-click on the gray rack area (not on a tube) or use the context menu 
„Remove selected rack“.

• Confirm the delete operation in the popup message with „Yes“.
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5.5.5 Solvents in Tray Configuration

Solvent can be defined at all positions in the tray configuration. The position must be a 
member of a zone (see "Adding Zones and Tubes to a Zone" on page 102).

Figure 5.7 The Solvent Configuration dialog box 

The Solvents Configuration button can be used to define solvent names in the "Sol-
vent Names Configuration".
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5.5.6 Reagent in Tray Configuration

Reagents can be defined at all positions in the tray configuration. The position must be a 
member of a zone (see "Adding Zones and Tubes to a Zone" on page 102).

Figure 5.8 The Reagent Configuration dialog box 

Reagents can be used in TASK procedures with the type “ADD”.

5.5.7 Barcode Zone Configuration

The barcode configuration dialog box can only be used if a barcode reader is installed.

Containers (carriers for racks) can be defined as “barcode defined racks”, whereas an 
automatic barcode reading can be performed here when starting the preparation pro-
gram.
58 Z31695_00_05



Z3169

Configuration
5.5.7.1 Defining Barcode Defined Racks

• “Double click” on the rack area, or on a dark gray container area, to define it as a 
“barcode defined rack” (or to undo this definition).

Figure 5.9 The Barcode Zones Configuration dialog box 

5.5.7.2 Checking Barcode Rack Information

Open the Tray View and select the “Barcode” view mode to see all “barcode defined 
racks”:

• A red frame will be displayed if the rack is a “barcode defined rack” 

• See Tool tips for details on rack information

When starting the preparation with “Autostart”, two barcodes from each “barcode defined 
rack” are read automatically: 

• If a valid Type Barcode and Barcode ID are read when executing the program, any 
older rack will automatically be removed and the new rack inserted.

See also: "Insert Racks with Barcode Simulation" on page 100.
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Figure 5.10 Example of a Gilson Tray Configuration 

(The example shows a tray configuration file (*.735) with only two “barcode defined 
racks”)

5.5.8 Ports in Tray Configuration

This configuration dialog box is for use only with applications used with SampleTrack 
(Profiler, SampleTrack)!

Ports with predefined names can be defined in predefined zones (one position only) in 
the tray configuration. Automatically defined ports include Injection and InjectionMS.

The Switch NMR and MS Port button can be used to switch the right/left position of the 
valves 819 in the tray.
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Figure 5.11 Example of a Ports in Tray Configuration

5.6 Z-Tower Configuration

The Z-Tower configuration dialog box allows the following settings to be changed:

• The Z-Tower size can be defined to 125 mm or 175 mm.

• The Z-Tower calibration clamp height can be defined (use the value written on the 
adjustment tube!).

• The barcode reader mounting position can be defined (old position: X = -49).
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Figure 5.12 The Z-Tower Configuration dialog box 

Note: Liquid level sensing is not used!
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5.7 Solvent Names Configuration

The Solvent Names Configuration dialog box is used to define the names of the solvents 
used in experiments.

Figure 5.13 The Edit Solvent Names Dialog Box

To insert a solvent name select the name from the NMR Solvent list or enter a tray or 
dilutor solvent. Press Add to add the solvent to the list.
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5.8 ValveMate Configuration

In the ValveMate configuration dialog box, solvents can be assigned to the ValveMate 
positions.

Figure 5.14 The ValveMate Configuration dialog box 

The Solvents Configuration button can be used to define solvent names in the "Sol-
vent Names Configuration" dialog box.

The Edit Automatic Wash Procedures button can be used to define wash procedures 
in the "Execution Mode Configuration".
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5.9 Valves & Capillary Configuration

In the Valves & Capillary Configuration dialog box:

• Properties of “Gilson 819” valves can be defined: name, GSIOC ID, default position.

• Properties of additional Bruker valves can be defined: name, Gilson output connec-
tor, default position.

Figure 5.15 The Valves & Capillary Configuration Dialog Box

5.10 Gilson Cover & LED Configuration

The Gilson Cover & LED Configuration dialog box is used to define the reaction after the 
cover is opened. Specifically:

• The input port of the “cover open switch”.

• The output ports of the Gilson status LED’s.

• The reaction when opening the cover (stop and wait until closed).

• The reaction when closing the cover (reading all barcodes again).
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Figure 5.16 The Cover Configuration Window
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6 The Rack Editor

6.1 Opening the Rack Editor

To open the Rack Editor select „Rack Editor“ from the Tray Control in the Tray Configu-
ration dialog box. 

The file “CustomRacks.geo” is used for customer defined racks. By a new installation it 
is not overwritten if it already exists. If it does not exist, it will be created as a copy of the 
empty rack file “CustomRacksEmpty.geo” (delivered with the setup file).

Warning shown when the file “CustomRacks.geo” does not exist when opening the Tray 
Configuration dialog box: 

Warning shown when the file “CustomRacks.geo” can not be created: 

Error shown if both custom rack files do not exist when opening the „Rack Editor“ dialog 
box: 
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Rack Editor without a carrier (other names: container or site) selected: 

See also: 

1. "Rack Selection" 

2. "Creating a New Rack" 

3. "Bruker or Custom Racks" 

4. "Modifying Racks" 

6.2 Rack Selection

When you click on a rack (that is placed in a carrier) it will show a light blue frame around 
the selected carrier, and the rack information will be displayed in the Rack Editor. 

Figure 6.1 Rack Editor with Rack Selected 
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Old Gilson defined racks do not have values for rows or columns. Only tube values in the 
tube list can be displayed!

6.2.1 Carrier Selection

When you click on a dark gray carrier area, it will show a light blue frame around the 
selected carrier and the Select rack button will be enabled: 

Figure 6.2 Selecting a Carrier

Using the Select rack button, a rack can be selected from a list of all racks that can be 
used for the selected carrier.

Figure 6.3 Selecting a Rack 
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“[Bruk]” racks in the selection list are delivered from Bruker with the installation and can-
not be modified. 

“[Cust]” racks in the selection list (at the end) are customer racks and can be modified. 

6.3 Creating a New Rack

After opening the Rack Editor the button “Create new Rack” is disabled: 

Existing rack values can be used by clicking on an existing rack in the tray view! Use 
existing rack values to add the new rack to the carrier list of an existing rack!

After manually changing the “Rack Name” edit field to a new rack name (not an existing 
Bruker rack name or custom rack name!) the button “Create new Rack” will be enabled. 

Define the total size of the new rack in the fields “Dimensions x” and “…y” (the values 
of an existing rack can be used by clicking on the rack in the tray view before changing 
the name).

Define the Carrier (list), where the new rack can be placed by clicking on an existing 
rack in the tray view (otherwise the new rack can only be displayed in the current 
selected carrier after typing the rack name manually)

List with no carriers defined (left) - List with carriers defined (right):
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The Create New Rack button will create the new rack as a “Custom” rack: 

When the button is pressed and a carrier is defined for the new rack, the new rack will be 
added to the bottom of the selection list:

“[Bruk]” racks in the selection list are delivered from Bruker with the installation and can-
not be modified. 

“[Cust]” racks in the selection list (at the end) are customer racks and can be modified. 

6.3.1 Deleting a Rack

A custom rack can be deleted using the Delete Rack button. Bruker racks cannot be 
deleted.
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6.4 Bruker or Custom Racks

Racks can be defined as Bruker racks or Custom racks.

6.4.1 Bruker Racks

• Bruker is shown in the upper left corner of the Rack Editor: 

• Rack data is delivered from Bruker with the installation and cannot be modified

• Rack data is defined only in the file “default.geo” 

• Racks are displayed in the selection list with the prefix: “[Bruk]” 

6.4.2 Custom Racks

• Custom is shown in the upper left corner of the Rack Editor:

• Rack data is defined by the customer and can be modified and deleted.

• Rack data is defined in the file “default.geo” and in the file “CustomRacks.geo”.

• Racks are displayed in the selection list with the prefix: “[Cust]”. 

6.5 Modifying Racks

First select an existing rack in the Rack Editor (see "Rack Selection" on page 68). 

Note: Only custom racks can be modified!

The Rack Editor can be used to define a Tube Matrix in a rack.

Old Gilson defined racks do not have values for rows or columns. Only tube values in the 
tube list can be displayed!

The total rack size can be defined in the edit fields “Dimension X” and “Dimension Y”: 
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The position of the top left tube of the matrix can be defined relative to the center of the 
rack or relative to the top left corner of the rack. 

The values of the opposite mode are calculated automatically using the total rack size in 
the fields “Dimension X” and “Dimension Y”. 

The number of rows and columns can be defined in the edit fields “Rows” and “Col-
umns”.

The space between two rows can be defined in the edit field “Spacing (Y)”.

The space between two columns can be defined in the edit field “Spacing (X)”.

An additional offset of even rows/columns can be defined in the edit fields “X Offset of 
even rows” and “Y Offset of even columns”. 

The Create New Matrix Tubes button will create all matrix tubes and display them in the 
tube list: 
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The Define size of all tubes button is used to open the “Set Tube Size” dialog box 
where the matrix tube size can be defined:

The mode Labels on Rows / Columns: „A1“...“H12“should be only selected if there is 
no offset defined for even rows or columns!

Pressing the Apply button saves the modified rack data in the files “default.geo” and 
“CustomRacks.geo” files and displays the data in the selected carrier highlighted with 
the light blue frame: 
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The yellow pop-up window displays all the tube values for easy verification!

6.6 Service Tools

The Service Tools are for trained Bruker Service Personnel Only!
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7 Preparation Data Files

7.1 Data Directory Structures

Structure:

[Install Folder Data]\G215Data\

\Config\

\Config\Restore\

\Proc\

\Easy\

\SPETT\

\Profiler\

\Test\for release test files 

\ProcTest\

\Easy\

\Profiler\

\Exec\

\Exec\Restore\

Obsolete folders:

\1mm\

\SampleTrack\

\Custom\

\BEST\

7.1.1 Main Folder

[Install Folder Data]\G215Data\ (defined when installing the program)

7.1.2 Configuration Files Directory 

[Install Folder Data]\G215Data\Config\

1. All data in the current configuration (file extension: *.cfg), including the tray file 
name, e.g. Current_Config_data.cfg.

2. Data in the current tray (file extension: *.735), including the tray geometry database 
file name, e.g.: Current_Tray_Config.735.
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3. Data of tray geometry database (file extension: *.geo). This file is used when insert-
ing racks (e.g. after barcode reading). e.g.: GRack_data_all.geo.

7.1.3 Preparation Procedure Files Directory 

[Install Folder Data]\G215Data\Prep\

Common procedure files used for initial control settings (file extension: *.gsp or *.gfp).

7.1.4 Temporary Settings Files

[Install Folder Data]\G215Data\Exec\

1. Saved Session file after an error or Menu "Save Current Protocol (... log) Files".

2. Current preparation status file (file extension: *.sts - currently not used).

[Install Folder Data]\G215Data\Exec\Restore\

All default setting files (file extension: *.pgi) to restore to installation values.

7.1.5 Temporary Protocol Files 

[Install Folder Data]\G215Data\Exec\

1. Current main protocol file of the current session (log_exec.log).

2. Current protocol file of the running procedure (log_current.log).

3. Saved protocol files (saved_log_exec.log and saved_log_current.log) after an error 
occurs or after saving the file with the menu "Save Current Protocol (... log) Files".

After completion of the SampleTrack order procedure the current protocol file, [Install 
Folder Data]\G215Data\Exec\log_current.log, will be renamed (to the order name) 
and saved in the SampleTrack order files directory:

[Order Folder]\bstsdata\gilson\out...\protocol\ 

See also: "View Current Protocol File" on page 40) and the "Directory Structure of Order 
Files" on page 81.
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7.2 Viewing Preparation Procedure Data Files

Press the Step View button in the Tool bar to display the currently loaded/running master 
step procedure. 

The menu selection Compare Procedures can be used to check/compare any proce-
dure. All steps are displayed in a text file similar to the current protocol file.

To find the file directory see the "Data Directory Structures" on page 77.

7.3 Protocol Files

Current Preparation Protocol File Directory: (see also: "View Current Protocol File" 
on page 40).

[Install Folder Data]\G215Data\Exec\

Two protocol files are written automatically:

1. Current main procedure protocol file: log_exec.log

2. Current protocol file of running procedure: log_current.log

After an error or when selecting menu option "Save Current Protocol (... log) Files" a 
copy of the current protocol files will be performed:

log_current.logto ...\G215Data\Exec\saved_log_current.log

log_exec.logto ...\G215Data\Exec\saved_log_exec.log
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After completion of the order procedure the current protocol file, [Install Folder 
Data]\G215Data\Exec\log_current.log, will be renamed (to the order name) and saved 
in the order files directory: 

C:\bstsdata\gilson\out...\protocol\ 

(See the "Data Directory Structures" on page 77)

Directory of saved protocol files after execution of orders: 

[Order Folder]\bstsdata\gilson\out\protocol\ - (when running with SampleTrack)

[Order Folder]\bstsdata\gilson\out_no_ST\protocol\ - (when running without Sample-
Track - 
e.g. BAY000100 NMR 31.log

(See the "Directory Structure of Order Files" on page 81).
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8 Order Files

8.1 Directory Structure of Order Files

Note: To allow access to old order information, old files will not be automatically deleted!

The user should delete all old orders in the subdirectories listed below by using:

The menu option „Service Tools“ + the button: 

Note: „order files“ in the JCAMP format will be used when working without SampleTrack

Note: „order files“ in the JCAMP format will be used when working with SampleTrack 
using the old file system (1 mm applications)!

Note: „order files“ in the XML format will be used when working with SampleTrack via a 
SOAP server (Profiler and SampleTrack applications)!

Directory Structure for Order Files:

[Order Folder]\bstsdata\gilson\

\in\

\in\exec\

\in\save\

\in\error\

\out\

\out\save\

\out\error\

\out\protocol\

\in_no_ST\

\out_no_ST\

8.1.1 Main Directory

[Order Folder]\bstsdata\gilson\ (defined by SampleTrack)

8.1.2 Input Order Files Directory 

[Order Folder]\bstsdata\gilson\in\ (when running with SampleTrack).

[Order Folder]\bstsdata\gilson\in_no_ST\ (when running without SampleTrack).
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Contains all order files (file extension: *.p) to carry out.

After pressing OK, the files will be moved into the directory \in...\exec\. 

After verifying an error the files will be moved into the directory \in...\error\.

After execution of the order, the files will be moved into the directory \in...\save\.

8.1.3 Output Order Files Directory

This results after execution.

[Order Folder]\bstsdata\gilson\out\ (when running with SampleTrack).

[Order Folder]\bstsdata\gilson\out_no_ST\ (when running without SampleTrack).

Contains all order files with results after execution (file extension:*.r).

After result handling by the SampleTrack Communicator, the files will be moved into the 
directory \out\save\ if status OK, or into the directory \out\error\ if an error occurs. 

8.1.4 Order Protocol Files Directory

Results after running the order procedure. 

[Order Folder]\bstsdata\gilson\out\protocol\ (when running with SampleTrack).

[Order Folder]\bstsdata\gilson\out_no_ST\protocol\ (when running without Sample-
Track).

After completion of the SampleTrack Order procedure, the current protocol file [Install 
Folder Data]\G215Data\Exec\log_current.log will be renamed (to the order name) and 
saved in the SampleTrack order files directory: 

[Order Folder]\bstsdata\gilson\out...\protocol\ 

(See also "Data Directory Structures" on page 77).

8.2 Viewing Order Files

To see the JCAMP SampleTrack order files:

1. Right-click on the order in the order list and select Show input order file to display 
the order information.

2. Right-click on the order in the order list and select Show output report file to see 
the report information.

To see the protocol files: Double-click on the order in the order list!

To find the file directory refer to "Directory Structure of Order Files" on page 81.
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9 Solvents

9.1 Defining Solvents for Preparation

To edit the solvents names used for preparation, open the "Solvent Names Configura-
tion", whereas:

• All defined external NMR solvents can be used.

• Additional solvents can only be defined for the preparation.

To define the solvent positions in the Gilson tray area for preparation, open the configu-
ration dialog box (see "Solvents in Tray Configuration" on page 57) and click on the 
place where you want to use the solvent:

To define the solvent positions at the Gilson ValveMate open the "ValveMate Configura-
tion".

9.2 Defining External NMR Solvents

The external NMR solvents are used inside the "Solvent Names Configuration", which is 
a dialog box used to define the preparation solvents used.

For Profiler applications the external NMR solvents are delivered by the Web Services 
server directly.

For other applications:

• The external NMR solvents are defined inside a text file (e.g. solvents.txt).

• The name of this text file can be defined in the configuration dialog box (see 
"Default Files Configuration" on page 50) or by clicking on the Gilson liquid handler 
215 (default files,...) to open the configuration Gilson 215 dialog box. 

Figure 9.1 External NMR Solvent Configuration 
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In the property sheet Default Files, the default file name and directory of the type Exter-
nal NMR solvent file can be changed to define the ambient solvent file used.

To view or edit the configuration see "Open Configuration View" on page 47.
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10 Edit Procedures

10.1 Modifying TASK Procedures

If the source TASK procedure is selected in the registry, then you must:

1. Modify the procedure in the menu “Service tools” -> "Modify Procedure" or using the 
Tool bar button. Select another TASK procedure if there is no correct TASK proce-
dure in the Registry entry.

2. Export the procedures and display them in the SampleTrack selection box using the 
menu “Service tools” -> "Initialize Pump"

10.2 TASK Procedures

TASK procedures are special procedures with a customer dialog box for each different 
type, used to easily change procedure parameters. 

10.2.1 Common TASK dialog box Elements

In the top of the dialog box the name of the procedure and the Custom (green) or 
Bruker (red) type is shown:

 

(see "Bruker or Custom Racks" on page 72)

With the ’...’ button another TASK procedure of the same type can be loaded.

TASK procedures can be saved using the ’Save As’ button (for all procedures) or using 
the ’Save’ button (for CUSTOM procedures only). Names of existing Bruker procedures 
can not be used!

The ’Cancel’ button can be used to close the dialog box without saving modifications.
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10.3 Types of TASK Procedures 

1. Common TASK procedures: 

"Task Procedure Wash"

"Task Procedure Clean"

"Task Procedure Add"

"Task Procedure Dispense"

"Task Procedure Mix"

2. Application specific TASK procedures: 

"Task Procedure 1MM Samples (not supported)"

10.3.1 Task Procedure Wash

Wash tasks are only used to perform an automatic wash procedure for a different Valve-
Mate solvent if this option is selected in the execution mode configuration (see "Execu-
tion Mode Configuration" on page 51).

Figure 10.1 Editor Dialog Box of a Wash TASK 

Optionally an intermediate solvent can be used.

If the Wash TASK will be used as the default wash procedure in the configuration, the 
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following check box must be selected: 

The default wash procedure can be selected in the configuration dialog box: 

10.3.2 Task Procedure Clean

Clean tasks can be defined as sub-procedures in each line of an Add Task!

Figure 10.2 The Modify Task Procedure Clean dialog box 

Clean tasks can be started using the menu without adding a task. To edit or to run clean 
procedures: see "Clean Procedures Menu Commands" on page 34.

10.3.2.1 Automatic Cleaning 

The clean procedure name is defined in the default files configuration (see "Clean Pro-
cedures Menu Commands" on page 34).

Select the appropriate options in the Settings dialog box (see "Edit Settings Menu" on 
page 22) to run this procedure. Automatic cleaning can be performed before the begin-
ning of the order procedure loop, and/or after the last order. 

This feature works only when starting with AutoStart button (shown at left)! 
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10.3.3 Task Procedure Add

An Add task is a flexible procedure that is designed to be modified by the user. All lines 
in the Add Task procedure list are executed from the top of the list to the bottom.

In the Add Task the user can modify a selected line (after selecting a line by clicking in 
the left column of the list) or add additional lines or delete lines.

In each line of an Add Task other tasks of the type can be defined and modified with the 
Edit button: 

• Task Dispense

• Task Mix

• Task Clean 

At execution time they will be performed after the execution of the line. In each line of an 
Add Task modifications must be updated in the list with the button!

The procedure list will be saved with the buttons Save As or Save. 

Figure 10.3 Modify Task Procedure ADD
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10.3.4 Task Procedure Dispense

Dispense tasks can be defined as sub-procedures in each line of an Add Task.

Figure 10.4 Modify Task Procedure Dispense

10.3.5 Task Procedure Mix

Mix tasks can be defined as sub-procedures in each line of an Add Task, but only after a 
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Dispense Task in the list.

Figure 10.5 Modify Task Procedure Mix

10.3.6 Task Procedure 1MM Samples (not supported)

Note: The „1MM” Application will not be supported from version 1.3 and it is recom-
mended that you use the "Task Procedure Add" of the „Easy” application in most circum-
stances!
90 Z31695_00_05



Z3169

Edit Procedures
Figure 10.6 Modify 1mm Samples Task

10.4 Modifying the Procedure Dialog Box

This dialog box is called from the Modify Procedure option in the View menu (see "View 
Menu Commands" on page 36). When selected this option shows or hides a Procedure 
View in the main window, which is used to modify Task procedures at a high edit level for 
customers.

The last selected TASK procedure is written in the registry (entry: ProcedureLastTask) 

Modification: 

• “Custom” procedures have a green „Custom“ identification at the top of the dialog 
box and can be modified:

• “Bruker” procedures are delivered from Bruker with the installation, have a red 
„Bruker“ identification and can NOT be modified. 
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With the button on the right, which is found on the right side of the current pro-
cedure, another TASK procedure of the same type can be selected: 

• If there was a TASK procedure of a different type selected the following message 
box appears: 

All procedures can be saved as a file with another name with the button:

But only „Custom“- procedures can be saved in the current file with the button:

For „Bruker“ procedures the following button is not active:
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If the current procedure in the Registry is not a TASK procedure the following message 
box appears: 
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11 Test/Service Tips

11.1 Service Information

1. Default Speed Z Axis

• Can be defined in the registry:  
 
Software > Bruker Biospin > Gilson Control > GExecCtrl > Z Speed 

• Values 1...5 (default= 4)
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How To... A

A.1 Introduction

The following tasks are discussed in the appendix:

"Define Application Type"

"Create Orders"

"Modify Task Procedures"

"Insert Racks"

"Insert Racks with Barcode Simulation"

"Adding Zones and Tubes to a Zone"

"Define Sort Orders"

A.2 Define Application Type

When starting the program the first time after installation the default procedure selection 
dialog box appears, allowing you to define the type of procedure and config settings in 
the registry.

Types of applications: (5 different types of applications can be selected) 

• Easy Preparation (working only without SampleTrack)

• SPE Tube Transfer (working only without SampleTrack)

• Profiler Preparation (working only without SampleTrack)

•

After performing an initialization using menu “Service tools” -> Initialize Pump, all pro-
cedures in the export directory (defined in the"Edit Settings Menu") will be exported to 
enable a selection of these procedures in the Create Orders dialog box (without Sample-
Track) or in the selection box of SampleTrack.

A.3 Create Orders

The Create Orders dialog box is used to create test order files if SampleTrack is not 
selected in the Edit Setting dialog box (see "Edit Settings Menu" on page 22).

The Tool bar button shown to the left is used to open the Create Test Order 
Files dialog box. If SampleTrack is selected in the Edit Settings dialog box, 
then the button will be shadowed and unavailable.
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Figure A.1 Create Test Order Files 

Variants for different settings:

"Insert Racks with Barcode Simulation" 

A.4 Modify Task Procedures

To modify a task procedure:

1. Open the modification dialog box with the menu “Service tools” -> Modify Procedure 
(see "Modifying the Procedure Dialog Box" on page 91) or Tool bar button. 
 
If the procedure export path is not correct, (e.g. another application was running) a 
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message box will appear:  

In this case select another TASK procedure in the current application folder.

2. Export procedures with the menu “Service tools” -> Initialize Pump (see "Initialize 
Pump" on page 29). 
 
Exported procedures will be displayed it in the selection box of SampleTrack or in 
the „Create Orders Dialog Box“ (without SampleTrack). 

A.5 Insert Racks

For applications with SampleTrack (Profiler, SampleTrack):

• Modifications of racks and zones in the ray area are not allowed!

• All rack insert and remove operations will be done automatically with the barcode 
reader!

In this step only the rack will be inserted. A zone will not be created and tubes will not be 
added to a zone! Use this method to define a zone for more than one rack or for a part of 
one rack.

To insert racks with a new zone and to add rack tubes to a zone see "Insert Racks with 
Barcode Simulation" on page 100.

A.5.1 Inserting a New Rack

Open the tray configuration in the configuration view. 

With the mouse right-click on an empty (gray) container area (= site), which will open the 
following context menu:

Select „Insert rack at selected site“.
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This will open the Select Rack dialog box where you can select a rack (you can also 
double-click on “Create Order Dialog” with your mouse):

“[Bruk]” racks in the selection list are delivered from Bruker with the installation and can-
not be modified. 

“[Cust]” racks in the selection list (at the end) are customer racks and can be modified. 

All tubes from the inserted rack are not assigned to a zone (with the color „white“). Only 
tubes assigned to a zone can be used in other configuration dialog boxes or in proce-
dure steps.

A.6 Insert Racks with Barcode Simulation

Barcode racks could be simulated manually without a barcode reader when defining the 
barcodes in a special input dialog box:

There are two ways to open the Tray Configuration:

1. Using the Configuration View 
 
Open the Tray Configuration in the Configuration View.

2. Using the edit mode in the “Create Order” dialog box. 
 
Use this only if no barcode reader is installed (defined in the base configuration): 

Selecting the checkbox “Edit Mode” will change the mode of the tray control: 
100 Z31695_00_05



Z3169
Tray Configuration: 

Step 1: Insert a barcode rack

With the mouse double-click on an empty (dark gray) container area or right-click on an 
empty (gray) container area, and select „Insert Barcode Simulation Data“ from the 
context menu.

In either case this will open the Select Rack dialog box where you can select a rack:

“[Bruk]” racks in the selection list are delivered from Bruker with the installation and can-
not be modified. 

“[Cust]” racks in the selection list (at the end) are customer racks and can be modified. 

Selection Error:

• The following selection error occurs when no barcode type label is defined for the 
selected rack (e.g. „Code 202“): 

Please contact Bruker or use another rack type if this error occurs!
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Step 2: Insert zone and add tubes to zone

After selecting the Rack Type, the tube numbering order and the rack ID must be 
defined: 

To insert well plates into a container rack, first insert the container rack (e.g. “205” or 
“205MI”), then the well plates (e.g. “WH12” or “WH12@1MM”).

The automatically assigned zone can be checked in the tool tip information of the new 
tubes.

When using a barcode reader to detect barcode racks automatically, refer to "Barcode 
Zone Configuration" on page 58 for information on the configuration!

A.7 Adding Zones and Tubes to a Zone

Open the Tray Configuration in the Configuration View.

Note: Only tubes assigned to a zone can be used in other configuration dialog boxes or 
in procedure steps.

When using "Insert Racks", all tubes are not assigned to a zone (displayed with the color 
white).
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A.7.1 Adding a Zone Manually

• Open the context menu Set Zone Properties from the tray control menu:

• In the Zone Maintenance dialog box select a zone from the zone list, or write a new 
zone name in the edit field, and press the Add button.

• Modify the color of the zone pressing the Color button.

• Modify the numbering order of the tubes that will be added to the zone in the section 
Starting Corner and Pattern.

• Press the OK button to temporarily save the new zone definitions in the tray config-
uration dialog.
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A.7.2 Adding Tubes to a Zone Manually

• Select a defined zone in the Zone Maintenance dialog box list, or click on a tube 
already assigned to this zone (the selected zone will be displayed in the zone edit 
dialog box).

• Use a „Lasso“ mouse operation (the Lasso frame will have the color of the selected 
zone) to add all tube in the lasso frame to the selected zone (only white-colored 
tubes that are not yet assigned to a zone can be added to the selected zone). 

A.7.3 Removing Tubes from a Zone Manually

Tubes can not be removed individually from a zone, the whole rack with the tube must 
be removed (see "Deleting a Rack" on page 71).

A.7.4 Adding Zones and Tubes Automatically

A barcode reader must be installed for this procedure.

Two barcodes will be read on each rack automatically:

1. Type Barcode

2. ID Barcode

During this procedure:

• A new rack of the type Type Barcode will be automatically inserted.

• A new zone with the name ID Barcode will be automatically created.

• All tubes for the rack will be automatically assigned to the new zone with the name 
„ID Barcode“ (see "Barcode Zone Configuration" on page 58).
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A.8 Define Sort Orders

Only for applications without SampleTrack!

Sorting orders defines which order will be at the top of the order list and prepared first. 

Select the sorting mode in the Edit Setting dialog box

All orders for all currently inserted racks can be sorted, or all orders inside one rack can 
be executed together: 

Orders can be prepared according to there creation time (first created order will be pre-
pared first) - check by Time:

The sorting by Order name (Position) sorts the preparation in ascending order:

Sorting by Solvent sorts the preparation in ascending order (when ValveMate is 
installed), but all orders with the currently connected solvent will be prepared first.
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